New Enrollment ACH Process Guide

KeyBank O

Use the red key.

Pay with ACH
User Guide

L Pay With ACH ..ooiveiiiiiiicc i
D A =Y R = 1 1= T

3. Managing SUD-USEIS .....c.iiuiiiiiiii i e e

KeyBank O

Use the red key.

17

22



New Enrollment ACH Process Guide

1. Pay with ACH

Pay with ACH service enables authorized usersto initiate electronic payments. You can either create these
transactions manuallyas one-time payments or create payments from atemplate. Our easyto use templates allow
you to create, store, and approve payments easilyfor paymenttypes including payroll, tax, and vendor payments.

1.1 Payment Management

* From your KeyBank Business Online dashboard, select Payments & Transfers.
» SelectPay with ACH. You maybe asked to verify your identity for securitypurposes.

Payments & Transfers Tools~ Support - “) ~ My Profile Sign Off

“— | Payments & Transfers X

What would you like to do?

Make a Payment

Make a Transfer

Pay with ACH

Pay Bills

Figure 1.1: Selecting Pay with ACH

» The ACH Home (Figure 1.2) will display. You will find manyoptions for managing your payments and customizing
your view. There are several options throughoutthe screen, including jump page links under ACH Menu, dropdown
listto Add Widgets, gearicons to resize or remove widgets. Each widgetprovides additional options to change
views, add or remove columns, rearrange columns and save your own custom view.

ACH Menu

ACH Home

(@) Payments andior Transiers await your spproval

Payments List View

Template List View

Oan | actons Tempiats ams Tompiats Deacription

Figure 1.2: ACH Home Page
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* Underthe ACH Menu options (Figure 1.3),you are able to access jump pages to other functions within ACH
including PaymentManagement (to create payments and templates), Beneficiary Address Book, Alerts Center, and
ReportManagement. Depending on your permissions, you may nothave access to all of these functions.

ACH Menu

ACH Home

Payment Management
User Maintenance
Bensficiary Address Book
Alerts Center

Auwdit Information foarted.

Report Management )
andior Transfers recently failed.

("o ) Reiected payments andior transfers ne=d your review.
Le)
:?] Payments andlor Transfers await your approval.

Add Widgst

Figure 1.3: ACH Menu Options

* Underthe Add Widget menu (Figure 1.4),you are able to add more widgets to the ACH Home page. The additional
widgetwill appear atthe bottom of the home page. Click and drag the widgetto change the order. Use the gear
icon above the widgetto resize or removeit. All of the widgetoptions are also grouped bytask and are accessible

on the ACH Menu jump pages (Figure 1.3).

Note: The Add Widget menu is onlyavailable for the ACH Home page.

ACH Menu

ACH Home

Notifications

N Y Y Y

(o) |

Files were recently imparted.

Recurring Payments andior Transfers recardly failed.

Rejectad payments andlor transfers need your reviev:

e| |e] (o]
LS

4

Payments and/or Transfers await your approval.

-

Alerts

Alarts Canter

Audit Information
Beneficiary Address Book.
Dowmload

File Impart History
Notifications

Payments List View
Recipient Group
Recipients

Recuming Payment Exceptions
Reports Management
Role Maintenance
Template List View

Usar Maintenanoe

Figure 1.4: Add Widget Menu

1.2 Setting the Default View

You are able to seta defaultview to see when you enterthe ACH module. Each widgetwith a View dropdown menu

provides a list of filters with presetcriteria to choose (Figure 1.5) and then Set As Default (Figure 1.6).

Payments List View # =
C 03102020 6320 P
Max display of info: 400 days £ 08/1012020 09:32 PM
a5
©4c 2 New Payment ® Cuiek Enty asa
Saas Dt || e
Fater | Seleotfeks -
Sl e e r——
Dan | s [ o | sy From account st curmcy | amamt | vewesse Credt/ Det Idicator | remeis
o 18 Sarm Siore 2T Appraved usD 4500 v aiel Crecit All Payments. 1COD Bushess pymis:
o w wmn zoo01744. @ Hesraved uso W  cazvae et CCD Busing APPYOVEI Window Paszed
Approved Paymants Moty S
o 3 wum M G r— = mo o ot
Future Dated Payments
Viving 1301 s Disay| 3 v | pergee < Poge| Imporied Payments
iy Payments
Agprove | | Unapprove | | Reet Dkt [————
Paymants Requiing Aggroval

Figure 1.5: View Menu
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You can also create a custom view to displaythe number ofitems per page and the columns ofinformation thatyou
wantto see. Clickonthe View dropdown menu and selectan option to filter the list (Figure 1.7).

* Change the number ofitems to Display per page using the dropdown menu atthe bottom ofthe widget.

Payments List View L
Max display of info: 400 days @ 2 0311/2020 07-42 PM
® Add 2 New Payment & Quick Entry & B
Filtar | Select fields - | SetAs Default [ Fure Dated Payments «
Oan | Actions ‘ 1] | Baneficiary Payment Typs From Acoount Status | Curs... | Ama... | ‘alus Date | Credit/ Dabit .. Templzts Daecription | Creafion Date ‘ Credit/ %
[m] Ve > 18 Sam Stone Consumer Payments 3270031448 @ Approved uso 45.00 270 Cradi 03052020 14:42:54 c
a . 10 MuLTI Corparatie/Vendor Payments 200001748 @ Approved uso 90.00 2020 Cradi CCD Business pymis OR062020 14:30:43 c
o Vi = 5 Jon Jacobe Payral TOBEISE Enisrad usn 200.00 CRATIHEND Credit CAOD0 5035 c
a View - 3 MuLTI Consumer Payments 329881108430 @ Redessed uso 180.00 EAVA0 Cradi 030X2020 21:16:58 c
iewirg 1-4 of 4 records Dsulay| 50 - |wuugc P::glz| 1 - |u‘
Approve Unapprove Reject Delete

Figure 1.7: Change View Menu

 Clickthe gear icon at the end of the row of column headers. Amenu will appear with all of the available columns.
Clickthe checkboxnext to the name to add or uncheckto remove columns for your view. Click Update (Figure 1.8).

Payments List View t-3
Max display of info: 400 days @ £3 031112020 07:42 PM
® Add 3 New Payment @ Quick Entry & B
Filter | Select fialds - | SetAs Default || Futee Daied Payments
p—
Oan | Actions | o | Bansnclary Payment Type From Account Statua | cure.... | Ama... | vElus Dats. Creart / Debit... Tempiate Description Creation Date | cmultl K- I
Amount [ Approval Cutalt [ Baich Name [ Beneficiary [ Benefisiary Accaunt [ Beneficiary Bark I
O Beneficary Bank Hame: O Beneficiary ID [ By Order Of Account Number | Campany [ By Ordar OF Mame | Company Name O Camment [ Crasted By
D
Creation Daie [ Credit / Debit [A Credit / Debit Indicator [ Credit Amaunt [ Currency [ Customer Reference
O Debit Account Name O Debit Account Number O Debit Amount [ Duplcate Reasan 0O Eniry Method O File Name
From Account =] [ Iwoice Number [ Last Appraver [ Last Modified By [ Madifiad Date
O Payment Details O Payment Identifier [ Payment Type O Passible Duplcate 0O Reject Reason [ Same Day ACH Payment
Slatus [ Tempiate Description O Temglate Narme O Teansaction Dale [ Value Date
Update | Cancel

Figure 1.8: Column Menu Options

* You may change the order of the columns from the updated widget. Clickand hold a column headerthen slide the
columninthelistto change the order.

* Clickthe View dropdown menu again. Clickon Save view (Figure 1.9, page 5).

* Add a name foryour custom view (Figure 1.10, page 5). Click Go to add it to the View Menu and click Set As
Default to save as the firstview you will see each time you access ACH. You are able delete your custom views
by clicking on the trash can icon that will appear following the view name.
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Payments List View »
Set As Default Future Dated Payments
Max display of info: 400 days ® © 0311172020 09:26 PM N
Your Custom Name] |
@ Add a New Payment @ Quick Entry & a From)|
— All Payments
Filter ‘ Select fislds - | SetAs Default | Future Dated Payments  ~ 32734 Y
- Approval Window Passed
n [ [0 ] o [ i | o [ o | oo ] 20000
O View ~ 16 Approvea 032772020 4500 Sam Stone Cansumer Payments 3273400314 All Payments Approved Payments
32968
(m] View v 10 Approved 0312012020 90.00 MULTI Corporate/Vendor Payments 200001744 Approval Window Passed Future Dated Paymenis
Approved Payments
[m] View o 5 Entered 031712020 200.00 Jdon Jacabs Payroll 3296811135 32968
Future Dated Payments Imported Payments
O View ~ 3 Released 0311312020 180.00 MuLTI Consumer Payments 3286811054 —]
Imported Payments
— ™ Y blay| ¢ My Payments
Viewing 1-4 of 4 records Display| 50 - My Payments L]
Payments Needing Repair Payments Needing Repair
Approve Unapprove Reject Delste P ts Requiring Ay I~ .
e o ! 2yments Hequiing Fpprova Payments Requiring Approval ~
Figure 1.9: View Menu Save View Figure 1.10: Add View Name

1.3 Add a New Payment

» To create an ACH payment, begin from the Payments List View widgeton the PaymentManagementjump page
accessible from the ACH Menu (Figure 1.3, page 3). This widgetcan also be added orremoved onthe ACH Home
page (Figure 1.4, page 3).

 Clickthe Add a New Payment option (Figure 1.11).

Payments List View -3
Max display of info: 400 days @ < 03/12/2020 07:51 PM
@ Add a New Payment |@® Quick Entry & B
Filter | Select fields - | SetAs Default | Your Custom Name
[ an ‘ Actions ‘ D ‘ Status ‘ Value Date ‘ Amount ‘ Beneficiary Payment Type From Account Template Description %
O View « 16 Approved 03/27/2020 45.00 Sam Stone Consumer Payments 327340031449 @
O View 10 Approved 03/20/2020 90.00 MULTI Corporate/Vendor Payments 200001744 @ CCD Business pymis
O View .- 5 Entered 03/17/2020 200.00 Jon Jacobs Payroll 329651113505 @
Viewing 1-3 of 3 records Disp\ay| 50 ~ |perpage Fage| 1« |of
Approve Unapprove Reject Delete

Figure 1.11: Add a New PaymentOption

* From the Add Payment box, you can clickthe Selecta Payment Template button and search for an existing
template to auto-fill paymentinformation. This optionis shown butnothighlighted (Figure 1.12, page 6).

* For one-time payments, you will need to fill out the paymentdetails. Startdetailing one -time paymentinformation
from the Select a Payment Type drop down box (Figure 1.12, page 6).
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Add Payment

® select a Payment Type Select a Payment Type

O selecta Payment Template

Consumer Payments

Corporate/Vendor Payments

Tax Payments

Figure 1.12: Add Payment

The Payment Type selected will determine the information you need to complete in the next section (Figure 1.13).
Once you selectyour Payment Type, click Continue.

* Required information isindicated with a red asterisk. The Originator ID is your company’s accountusedto offset
the paymenttransaction. The Value Date is the date the paymentwill creditthe beneficiary; the paymentmay be
sentfor processing two days in advance. Use optional fields such as Company Discretionary Data or Internal
Comments for your internal reference.

‘Criginator Information

* onginator I * vialue Dafe

FEDERAL MARKET C-K073125001- Offsat Account 200001744 % 0372020 [ | O wake this 3 Same Day Paymant

Bateh Description Company Discrefionary Data Da Intarnal Commanita
PRYROLL ’ :

Beneficiary Information

“ Mame Q,  *Bank Code @  *Account Humber * Account Typs “ Amount
0.00 usD

(1] Discretionary Data Internal Comment

O Create Prenate [ Hald
> Beneficiary Exclusion Dates

Add Ancther Beneficiary |  Clear Beneficiary Info

0.00 usb 1o 0 Beneficiaries on 17 Mar 2020

B Save this paymeni as a iemplate for fulue we @

< bamd

Figure 1.13: Add PaymentValue Date and Required Fields
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» For one-time payments, complete the Beneficiary Information section (Figure 1.14) with the information required,
including: the payee Name, Bank Code (bank routing number), AccountNumber, Account Type (checking, savings)
and Amount.

= Payments made from atemplate will prefill the Originator ID and Beneficiarydetails. You would enter the
appropriate value date and paymentamount. Referto section 1.5 (page 10) for Template information.

* Some paymenttypes allow for additional information to send with the payment. Addenda can be added usinga
field that will countcharacters and provide the numberremaining characters available.

* Clickthe Add Another Beneficiary button to include multiple recipients ofthe same paymenttype.

Beneficiary Information

* Nama C}  *Bank Cods @ *Account Mumber * account Typs * Amount

0.00 usn

1] Diserstionary Data Internal Commant

O Create Prerote O Hald

» Beneficiary Exclusion Dates

Add Ancther Beneficiary |  Clear Beneficiary Info

0.00 usb 10 0 Beneficiaries on 17 Mar 2020

W Save this payment as a template far fulsre we ()

= | -

Figure 1.14: Add PaymentBeneficiaryInformation

* When paymententry details are complete, click the Submit button (Figure 1.14). You will receive a Payment
Submitted confirmation (Figure 1.15) above the Payments List View widget.

Payments List View

+ Payment Submitted

1D: 10

To: Multiple Beneficiaries

From: FEDERAL MARKET CO INC 1744 200001744
Amount 90.00 USD

Value Date: 03/25/2020

Payment Type: Corporate/Vender Payments

Figure 1.15: Payment Submitted Confirmation

* In the Payments List View, the paymentstatus is Entered. It mustbe Approved in orderto be processed.

KeyBank O
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1.3.1 Quick Entry

» To create an ACH paymentusing the Quick Entry option,you mustuse atemplate thatis saved with only one
beneficiary. The single beneficiarytemplate mustalso be in an Approved status.

» Begin from the Payments List View widgetonthe PaymentManagementjumppage accessible from the ACH
Menu (Figure 1.3, page 3). This widgetcan also be added orremoved onthe ACH Home page (Figure 1.4, page 3).

 Clickthe Quick Entry option (Figure 1.16).

Payments List View -1

Max display of info: 400 days @ & 031172020 09:26 PM

@® Add a New Payment | @ Quick Entry

Filter | Selact fields - Future Dated Payments =

& B

Figure 1.16: Quick Entry Option

e On the Quick Entry screen, search and selectfrom yourapproved, single beneficiarytemplates. Use the calendar
to assign a Value Date. Entera payment Amount. Click Add Quick Entry to add another payment (Figure 1.17).

* When all payments have been added, clickthe Submit button.

ACH Menu

Quick Entry

*= Template Name Value Date Amount

Template/group name, beneficiary or payment type - *

@® Add Quick Entry

m Cancel

Figure 1.17: Quick Entry Fields and Command Buttons

* You will receive a confirmation onthe Quick Entry screen (Figure 1.18).

Quick Entry

+ 1 Payment Processed » Details

ID: 25

Account Number: 327340031449
Amount: 500.00

Beneficiary: Brittany Braggs
Currency: USD

Type: Payroll

Value Date- 03/20/2020

Result: Entered

* Template Name Value Date Amount

Template/group name, beneficiary or payment type . *

@ Add Quick Entry

Figure 1.18: Quick Entry Confirmation - PaymentEntered
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* Important to note that the resultis an Entered payment. It mustbe Approved in orderto be processed. Payments
are approved in the Payments List View widget. You may use the carrot at the top or the Cancel button (Figure
1.18, page 8) to return to the ACH Home page. Or use the ACH Menu dropdown to access the Payment
Managementjump page.

1.4 Approve aPayment

» After submitting a payment, return to the Payments List View widgetwhere the new paymentis listedin an
Entered status (Figure 1.19).

* Payments in Entered status require approval to be processed.

» Selectthe checkbox nextto one ormore payments you wantto approve. Select the Approve commandbutton to
change the paymentstatus.

Payments List View *
Max display of info: 400 days © < 03M12/2020 09:57 PM
@ Add a New Payment @ Quick Entry & B
Filter | Select fields - | ‘Your Custom Name
O an | Actions | s} I Status I Value Date | Amount | Beneficiary Payment Type From Account -3
O View 19 Deleted 04/01/2020 125.00 Brittany Braggs Payroll 327340031448 @
O View « 16 Approved 03/27/2020 45.00 Sam Stone Consumer Payments 327340031449 @
View -r 10 Entered 03/20/2020 80.00 MULTI CorporateVendor Payments 200001744 @
] View ~ = Entered 03/17/2020 200.00 Jon Jacobs Payroll 329661113505 @
Viewing 1-4 of 4 records Disp\ay| 50 - ‘per page Page| 1 - |of
Approve Unapprove Reject Delete

Figure 1.19: Approve One or Multiple Payments in Entered Status
* Or, selectthe Approve option from the Actions dropdown menu to approve a single payment (Figure 1.20).

(| Wiew - 10 Entered

(| Wies I Approve I Entered
Delete

Viewing 1-4 of 4 recor;  Modify
Reject

Approve Unapprove Reject Delete

Figure 1.20 Approve One Paymentin Entered Status

* Important! You needto prefund your payments. Your accountwill be debited 2 business days before the assigned
Value Date on your approved payments.
- If you Approve a paymenton Monday that has a Value Date of Friday, your accountmustbe fully funded
for Wednesdaymorning.
- If the paymentis approved 1 business before the Value Date or for Same Day processing, your account
will be debited the day itis Approved.

KeyBank O
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1.5 Templates

To simplifyyour experience, you have the capabilityto create and store templates for future use. When making
multiple or recurring payments, follow these guidelines to create the appropriate template for your needs.

* Templates are created and managed in the Template List View widget. Begin by selecting the Payment
Management jump page from the ACH Menu dropdown menu. This widgetcan also be added orremovedonthe
ACH Home page (Figure 1.21).

ACH Menu

ACH Home Add Widget v

Payment Management

User Maintenance
Beneficiary Address Book
Alerts Center

Audit Information praz=d View

Report Management

andfor Transfers recently failed. View

( 0 ) Rejected payments andlor transfers need your review. Mo

‘:1_\"‘ Payment and/or Transfer awaits your approval.

View

Figure 1.21: ACH Menu and Add WidgetOptions

» Template List View lists all templates thathave been created and provides access to template details and available
actions (Figure 1.22).

Template List View %
~
<

@ Add a New Template o B

Filter | Select fields - Active Templates

lan Template Na... Template Descrip... From Account Beneficiary Payment Type Am... Scigk..
O View - BiweeklyPay... Hourly Employees 327340031449 @ MULTI Payroll Approved 20.00
O View - TopGunSecurity security guards 320681108430 @ Top Gun Security Corporate/Vendor Payme... Entered 0.00
Viewing 4-5 of 5 records Display| 3 ~ |perpage ¢ Page| 2 ~ |of
Approve Unapprove Reject Delete

Figure 1.22: Template ListView and Add a New Template Option

» Similarto Payments List View, this view lists all templates and can be customized bythe user.

* You can choose the filtered view, columns thatyou wish to see, and number ofitems to displayper page in the
template listview (section 1.2 Setting the Default View, page 3).

* The status displayed in the Status column determines the available actions for each template.

* The template listcan be filtered using the View dropdown menu. Since templates cannotbe used until theyhave
been approved, the Templates Pending Approval option provides a quickway to look for templates needing
approval.

KeyBank O
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» Available actions for each template can be accessed in the Actions column.
» Additional actions are displayed in the command button row along the bottom ofthe widget.

* Checkboxes used with the row of command buttons (Approve, Unapprove, Rejectand Delete) allow you to apply a
single action to multiple templates.

» Template details are accessed byselecting an option underthe Actions column. Clickon View or selectan option
from the dropdown menu in the template row.

Create Templates
* From the Template List View widget, clickthe Add a New Template option (Figure 1.23).

Template List View

[¢]

@ Add a New Template & B

Filter | Selact fields . j

Active Templates

] an ‘ Actions | Template Na... | Template Descrip... From Account Beneficiary Payment Type Status ‘ Am... | Scig..
O View = BiWeeklyPay... Hourly Employees 327340031445 @ MULTI Payroll Approved 20.00
O View - TopGunSecurity security guards 329681108430 @ Top Gun Security ... Gorporate/Vendor Payme.. Entered 0.00
< >
Viewing 4-5 of 5 records Display | 3 - ] per page £ Fage‘. 2 - ]uf
Approve Unapprove Reject Delete

Figure 1.23: Add a New Template

* From the Add Template box (Figure 1.24), selectthe type of paymentfrom the Template Type dropdown. The type
of paymentselected will determine the information you need to complete on the next screen. Once you selectyour
Template Type, click Continue (Figure 1.25).

Add Template Add Template

Template Type

Select a Template Type - Template Type

| Q Payroll

Consumer Payments

Corporate/Vendor Payments

Payroll c
ayre Continue Cancel
Tax Payments

Figure 1.25:
Add Template Continue

* A new Template Information screen appears. Required information is indicated with ared asterisk (Figure 1.26,
page 12).

Figure 1.24: Add Template Type

* Enter a unique Template Name (no special characters or spaces) and Template Description.

* The Originator ID is accountused to offsetthe paymenttransaction. Optional fields such as Company
Discretionary Data or Internal Comments are for your internal reference.

* Complete the Beneficiary Information fields. Click Add Another Beneficiary until all recipients are entered. You
may add multiple beneficiaries ofthe same type to a single template or payment.

KeyBank O
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= Keep personal accounts (Consumer Payments, Payroll) and business accounts (Corporate/Vendor
Payments, Tax Payments) separate. All beneficiaryaccounts mustmatch the template type and

paymenttype.

Template Information

* Template Name * Template Description

-no special characters or spaces

Onginator Information

* Originator 1D

Batch Description Company Discretionary Data Descriptive Date Internal Comments

I Stored with the transaction, but not forwarded with the payment I

Beneficiary Information

* Name Q * Bank Code Q * Account Number * Account Type Amount

D Discretionary Data Internal Comment

O create Prenote [ Hola

I Stored with the transaction, but not forwarded with the payment I

> Beneficiary Exclusion Dates

Add Another Beneficiary Clear Beneficiary Info

[ Make Recurring

0.00 w0

+ Save Save for Later

Figure 1.26: New Template (Payroll example)

« In the Beneficiary Information section (Figure 1.26), enter the payee Name, Bank Code (bank routing number),
AccountNumber and Account Type (checking, savings). A transaction Amountcan be entered. If the amountwill
vary for each payment,itis recommended to save 0.00in the template.

» Hold and Prenote options are available if needed.

KeyBank O
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Hold: This option to cause specific beneficiarypayments to be withheld from payment processing while the
other beneficiaries process.
Create Prenote: This option sends a “zero” dollar transaction to the beneficiaryaccountprior to the first
transaction on a new beneficiaryaccount. The purpose is to verify the accuracy of the accountinformation.

* Make Recurring option allows you to seta schedule to automaticallycreate paym ents from atemplate. Itis most

usefulwhen anamountis saved in the template. Recurring payments will automaticallyappearin the Payments
List View inan Entered status. This still requires that you Approve the paymentforitto be processed.

- Referto Section 2 Alerts Center for information on Automatically Created payments email alerts.

 Alistof beneficiaries will display near the bottom of the screen as you enterthem. Use the options accessed from
the Actions columnto View, Modify or Delete individual entries (Figure 1.27). These actions are also available to
Modify an existing Template.

Add Another Beneficiary Clear Beneficiary Info

Filter

Select fields - | Edit Hold ~ Edit Amounts ~ All Beneficiaries

[ an I Actions I Name | | Bank Code Account Number Account Type Amount ‘ ceY, | Prenote | Hold ‘ Statusge
O View - Humpty Dumpty 253275964 9876354 Checking 0.00 usD No No
O View - Bobby Shafto 241281772 987654 Checking 0.00 usD Mo No
O View - Brother John 101002910 321654987 Savings 0.00 usD No No
Modify i — —
Viewing 1-3 of J recont Delete DISDIEV‘ 50 =~ |perpage Page| 1 ~ |of

Delete

[]Make Recurring

0.00 usb to 3 Beneficiaries

v Save Save for Later

Figure 1.27: Template Beneficiary Summary View

* Use the command buttons along the bottom atanytime: Save, Save for Later or Cancel (Figure 1.27).

« After clicking Save, you will receive a Template Submitted confirmation (Figure 1.28) above the Template List View
widget.

Template List View

+ Template Submitted

Template Name: GooseLandPyrl

To: Multiple Beneficiaries

From: FEDERAL MARKET CO INC 1010 327821001010
Amount 0.00 USD

Payment Type: Payroll

Figure 1.28: Template Submitted Confirmation
* In the Template List View, the template status is Entered. It mustbe Approved to be available for payments.

Approve a Template

* Templates thatare saved or submitted can be accessed inthe Template List View widgetfor further edits or
actions.

» SelectPayment Management from the ACH Menu dropdown (Figure 1.29, page 14).

KeyBank O
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ACH Menu

ACH Home

Payment Management

User Maintenance

Add Widget v

Beneficiary Address Book
Alerts Center
Audit Information orted View

Report Management .
andlor Transfers recently failed. View

( 0 ), Rejected payments and/or transfers need your review i

‘:T\, Payment andlor Transfer awaits your approval. view

Figure 1.29: Access PaymentManagement

* You can view templates from the Template List View widget (Figure 1.30).
» Templates in Entered status require approval to be processed.

» Selectthe checkboxnextto one ormore templates you wantto approve. Selectthe Approve commandbutton to
change the template status.

@ Add a New Template & B
Fitter | Select fields - Active Templates
O an Actions Na... D From Account Beneficiary Payment Type Status Am... ScH..
@ View GooseLandPyd Mother G's Long Timers 327821001010 @ MULTI Payroll Entered ooo
O View = Rebates Quarterly Discount 200001744 @ MULTI Consumer Paymenis Approv... 4000
O View v CEQpayout Monthly Bonus 327340031449 Brittany Braggs Payrall Approv 0.00
Viewing 1-3 of & records Display| 3 ~ |perpage Page| 1 =~ |of2 3
Approve Unapprove Reject Delete

Figure 1.30: Approve Template

 Or, selectthe Approve option from the Actions dropdown menu to approve a single template (Figure 1.31).

(| Wiew - 10 Entered

(| Wies I Approve I Entered
Delete

Viewing 1-4 of 4 recor;  Modify
Reject

Approve Unapprove Reject Delete

Figure 1.31 Approve One Template in Entered Status

KeyBank O
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1.6 Reporting

ReportManagementis an integral feature to ACH. This multilayered system provides options to filter, save,

and view reports.

* Access Report Management jump page from the ACH Menu dropdown.

Report Menu

+ View a listof available reports from the Reports Management page (Figure 1.32). Click on View for a
given reportto run the report or choose various reportcriteria to refine reportresults.

Reports Management

Filter | Select fields - ‘

1%

< 03/18/2020 02:15 PM

Actions I || Report Name Configuration Name Report Group Report Subgroup 2
View ACH Company Report Payments Administrative

View Company Details Admin

View Roles Admin

View User Permissions - Client Admin

View Template Detail Report Payments Payments

View Payment Detail Report Payments Payments

Viewing 1-6 of 6 records

Display‘ 50 ~ | perpage Fag5| 1 - |of

Figure 1.32: Reports ManagementPage

Working with Reports

» The examples are from a PaymentDetail Report. SelectView from the Actions column for a report (Figure 1.32).
* Clickthe Run Report button for a reportof allitems. Use one or more filters to narrow the results (Figure 1.33).

Some reports will have required fields.

* Checkthe Save this Report boxto create custom reportviews with selected filters. Entera Configuration Name
for your custom reportwhen prompted. Acopy of the original report with the configuration name will save on the

Reports Managementpage.

* Click Cancel to return to the Reportlist(Figure 1.32).

Payment Detail Report

Report Criteria

D

is equal to o
Creation Date
Amount

is equal to e
Value Date

[[] Save this Report

Figure 1.33: Payment Audit Trail Filters

KeyBank O
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Report View and Toolbar Options

* PDF versions displayforeach reportin a window below the Run Reportbutton with view and navigation options

(Figure 1.34).

» Usethe Export As dropdown to selectPDF, CSV or Plain Text formatoptions.
» Usethetoolbaricons to decrease (-) orenlarge (+) the report. You are also able print,save oropenin a newtab a

PDF version of the report.

» A scroll bar appears along the side ofthe reportwindow to move through multiple pages. Using the Openin New
Tab icon (&) may provide a better experience for longer reportresults.

Comments:

Audit Information

Export As W
10f2 - 4+ & ]
-
Payment Detail Report | 90073125 | FEDERAL MARKET CO INC Mar 18, 2020 3:07:31 PM
1D: 14 Company Namea: FEDERAL MARKET C Company ID: KO73125002
ACH Company/
From Account: FEDERAL MARKET CO INC 1449 Value Date: 03/09/20
Payment Type: Payrall Batch Status: Released
Comp Dise Data:

Template: CEOpayout [ Monthly Bonus Entry Method: Created from Template

Prenates:

o

User ID Campany Timestamp
Entered FEDMARKET 90073125 Mar 5, 2020 2:36:23 PM
Approved FEDMARKET 90073125 Mar 5, 2020 2:36:47 PM
Debit / Account Payment
Beneficiary Name Beneficiary ID Amount Credit From Account Type Status Identifier Trace ID
Brittany Braggs 100.00 Credit 1239554 Checking Entered 45767894  041001030000001
Batch Totals
Item Count
Debits: ]
Cradits: 1

Figure 1.34: PaymentDetail Report (example)

Report Detail Highlights

* The type of information varies with each report. Example ofa Payment Detail Report (Figure 1.34).
* Header information provides the offsetting From Account, Payment Type, Template name ifused, Value Date and

Status of payment.

» Audit Information provides the user, actiontaken andtime.

» Beneficiary details including amountand recipientaccountinformation.

KeyBank O
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2. Alerts Center

We highlyrecommendthatyou setup email alerts. The Payments Awaiting My Approval and Payment Cutoff
Time Warning alerts add an extra layer of insurancethatyou not miss the approval step ofyour entered payments.
Entered payments require approval to be processed.

In the Alerts Center, you are able to choose one ormultiple alerts. You can manage alerts, manage email recipient
addresses,and setup groups ofalertrecipients.

* Begin by selecting the Alerts Center jump page from the ACH Menu dropdown menu (Figure 2.1). The Alerts
Centercan alsobe added orremoved as awidgeton the ACH Home page (Figure 1.21, page 10).

ACH Menu

ACH Home

Payment Management
User Maintenance
Beneficiary Address Book

Alerts Center

Audit Information

Report Management

Figure 2.1: ACH Menu Jump Page to Alerts Center

Recipients

Email recipients are easilystored and modified in this partof ACH. Here, you caninputnew information, categorize
and manage groups. You will add recipients to email alerts either individuallyor as a group of individual addresses.

* It isimportantthatyou add yourselfas an email recipient.
* The Recipients sectionlists all email recipients (Figure 2.2). They mustbe added to an alert to get the notification.

Alerts Center -]

Alerts Recipient Groups Recipients

& B O 031192020

Fiter | Select fields .

] an Actions Company Name *

Modify - | 90073125 Amanda Apple

O

O modify| Delete ) 90073125 Mark Mendoza

View
O Modify 90073125 Tom Turiy

Viewing 1-3 of 3 records Di9p|ay| 50 - |p5r|,age Pagg| 1 - |°f

Delete

Figure 2.2: Alerts Center Email Recipients

* To enter anew email recipient, click on Insert. A blank Recipientscreenappears.

» Enter the Name and Email Address. You can add multiple addresses forarecipientby selecting the Add Another
Contact Method button on the Recipientscreen.

» Selectthe Save button. A confirmation message Client Email Recipients Submitted will appear.
* From the Actions column, you can Modify, Delete or View email recipients onthe list(Figure 2.2)

KeyBank O
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Recipient Gro

ups

Once you have recipients established, you can create a group for selectrecipientsto all receive the same alert.

» SelectRecipient Groups andthen Insert (Figure 2.3)

Alerts Cen

ter

Alerts

Recipient Groups

Recipients

Filter | Select fields

& B

< 03/19/2020

Figure 2.3: InsertRecipientGroups

» On the Add RecipientGroup screen, entera Group Name.

 Clickin the Recipient Name field. Your recipients email addresses will populate a dropdown list. Selectthe emails
for the group. You are able to remove any recipientby clicking on the x to the rightof the address (Figure 2.4).

Add Recipient Group

Recipient

Pay Mast

Group

Group Name

ers

* Recipient Name

Tom Turly - TTurly@fedmkt.com

Amanda Apple - A_Apple@fedmkt.com ¥ | | Suzanna Samuels - S_Samuels@fedmkt.com * ‘

Mark Mendoza - M_Mendoza@fedmkt.com

Figure 2.4: Add Recipient Group

» Selectthe Save button. A confirmation message RecipientGroup Sub mitted will appear.
* From the Actions column, you can Modify, Delete or View email recipientgroups on the list (Figure 2.5).

@® Insert

+" Recipient Group Submitted

Filter | Select fields

& B

< 03/19/2020

oo D

1 an

Actions

Name

]}

Modify ~

Pay Masters

Viewing 1-1

View

Delete
1 kescorgg el

Delete

per page

Display | 50 ~

Fage| 1 - ‘uf

Figure 2.5: Listof Recipient Groups
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Alerts

Once you have added yourselfand any others you wish as recipients, you can begin to create alerts. You will be able
to add eitherindividual email addresses or your custom groups of recipients to each alert.

* The Alerts section lists all the currentalerts (Figure 2.6).

* From the Actions column, you can Modify, Delete or View email alertsettings and recipients/recipientgroups.
* To begin,selectAdd New Alert.

Alerts Center w*

Recipient Groups Recipients
@® Add New Alert & B O 037202020

Filter | Select fields -
Jan Actions I Alert Name ‘ Alert Group Alert Type Alert Subject Line ‘ Recipient £
O MODIFY - Member Discounts Payments and Transfers Payment Cutoff Time Warning Alerts - Payment Cutoff Time Warning Mark Mendoza 1
| MODIFY ~ Payments to apprpve Payments and Transfers Payments Awaiting My Approval You Have Payments andior Transfers Awaiting Approval TTurly@fedmkt.i
< | DELETE ] >
Viewing 1-2 f 2|records VIEW Disp\ay| 50 - |perpage Fage| 1 - |u|

Delete

Figure 2.6: Add New Alert

Complete the New Alertinformation. Required fields are marked with a red asterisk.

» Alert Name — a custom name thatyou give the alert.

» Alert Group — selectPayments and Transfers or Administration from the dropdown menu. Subsequentfields
appearbased onthe selected Alert Group.

» Alert Type — selectfrom the dropdown menu options. Subsequentfields appearbased onthe selected Alert Type.

n New Alert

* Alert Name

Employee Payroll

* Alert Group * Alert Type * Alert Subject Line
Payments and Transfers x v Payments Awaiting My Approval x v You Have Payments and/or Transfers Awaiting Approval
ou may change this subject line that rs on the email alert
* Schedule Hours * Schedule Minutes. * Time Zone
15 x v 0o X v EST US/Eastern - US/Eastern

* Recipients/Recipient Groups (@

— [ —— . One Recipient Group OR one or more
Recipients/Recipient Groups {
Recipient Groups Y|, recipients can be added to an alert

Pay Masters ‘

-

Amanda Apple - A_Apple@fedmkt.com

Mark Mendoza - M_Mendoza@fedmkt.com
Suzanna Samuels - S_Samuels@fedmkt.com

Tom Turly - TTurly@fedmkt.com

Figure 2.7: New Alert — Payments Awaiting My Approval (example)
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» Alert Subject Line — automaticallypopulates based on Alert Type. You can customize the subjectline (Figure 2.7,
page 19).
* Schedule Hours — 24-hourtime format(e.g. 14:00 instead of 2:00 p.m.). This is the time of day the alertis sent.
* Schedule Minutes — are on the quarter hour (00, 15,30 or 45).
0 An alertwill not be sentif the condition does notexistat the scheduled time ofthe alert.
» Time Zone — specifieswhich timezone the Schedule Time refers to.
o IMPORTANT! Paymentprocessingis donein EasternStandard Time. Carefullyreview the service level
disclosure statementthatappears each time you access Paywith ACH.
* Recipients/Recipient Groups — clickin the field for the listing of your individual recipients and anygroups you may
have created.
o Notice the information message aboutadding recipients to the alert (Figure 2.8)

) One Recipient Group OR one or more

* Recipients/Recipient Groups () .
| recipients can be added to an alert.

Figure 2.8: Adding Recipients — Information Message

0 Recipients will appear onthe screen under Contact Methods. Take the time to confirm thereis a check
in the box next to theiremail address. If the boxis blank, they will notreceive the alert (Figure 2.9)

* Recipients/Recipient Groups @

Mark Mendoza »  Tom Turly - TTurly@fedmkt.com = || |

Note: You may add additional recipients to this alert, but not a
recipient group. Both recipients and recipient groups cannot be
added at the same time.

Contact Methods

[ anEmails
Mark Mendoza M_Mendoza@fedmkt.com
Tom Turly [ TTurly@fedmkt.com

Figure 2.9: Adding Recipients —Checkthe Email Address Box

» Additional fields for each alertwill vary. Not all fields will be required. Forinstance,you do not needto specifya
paymenttype unlessyouwantto limitwhatalerts the recipient(s) will receive. Paymenttypes displayed will be
based on your permissions.

* Once allrequired fields are entered, selectthe Save button at the bottom ofthe New Alert screen. A confirmation
message Alert Submitted will appear. Youralertwillnow be displayed inthe Alerts list(Figure 2.6, page 19).
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Email Message

From: Notifications@Keybank com
To: user@company.com
Date: 08/14/2014 1:00 PM
Subject: You Have Payments Awaiting Approval

This alert has been sent to you because you have payments awaiting approval

2 transactions match this alert

Emall Message
From: Notificatons@Keybank com
To: user@company.com
Date: 08/14/2014 10:00 AM
Subject: Payments Automatically Generated

This alert has been sent to you nolifying you that payments have been
automatically created based on your automated scheduled payment settings.

1 transaction match this alert

Emall Message

From: Notftications@Keybank com
To: user@company.com
Date: 08/14/2014 3.00 PM
Subject: You Had Payments Approver Rejected Today

This alert has been sent to you because payments were approver rejected
today.

3 transactions match this alert

Email Samples

Payments
Awaiting
Approval

Payments
Automatically
Generated

Approver
Rejected
Payments

Figure 2.10: Sample AlertMessages
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» Alerts are sentas plain text, include the alerttype inthe Subject line or your customized subjectline,and language
that identifies how manytransactions are matched in this alert (Figure 2.10).
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3. Managing Sub-Users

Pay with ACH enablesyou to add and modify sub-usersto use the service. You can manage sub-user access and
permissions through the Manage Access service. You can modifywhataccounts a sub-user has accessto forthe
Pay with ACH service.

* Permission changes for sub-users can take up to 10 days to process. Eachtime achange is submitted, itis
processed as a separate requestthatis processed after the previous request, so frequentchangesto sub -user
permissions maytake longerto process.

* When modifying ACH settings, you may be asked to verify your identity for security purposes.

3.1 Viewing Sub-User Permissions

You can view sub-users and their permissions using the Manage Access service which is accessible from the Tools
menu on your KeyBank dashboard.
» SelectManage Access from the Tools menu (Figure 3.1).

Payments & Transfers ~ Tools Support - gﬂ - My Profile Sign on

o [ Tools >4

Current Services

Manage Access

Pay with ACH

Figure 3.1: KeyBank Dashboard

» Select Manage Sub-Users (Figure 3.2). » Selecta Sub-Userfrom the list (Figure 3.3).

» Select Change Permissions
Manage User X
< | Manage Existing Users X
Select an action.

Select a sub-user.
Add New Sub-User
Active Sub-Users

Active sub-users currently have permission to view and/or edit

Sub-users can only be granted access to business accounts. Sub- your business accounts.

users will not be able to view any personal banking accounts
related to you. Creating a new profile includes: Select a name to edit or suspend a sub-user.

Entering contact information
Entering a social security number

= : 3 CLS Loan
« Entering a date of birth

« Selecting business and account access

« Selecting permissions Test Test

Create User
Manage Sub-Users

Access Test

View and edit the information and permissions for existing sub-
users.

Figure 3.3: Sub-User Selection
Figure 3.2: Manage Sub-User Menu
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You will see a summaryof the sub-user’s permissions. ACH permissions are near the bottom ofthe list(Figure 3.4).

Figure 3.4: Sub-User ACH Permission Summary

3.2 Changing Sub-User Permissions
You can modifysub-user ACH permissions from the Permission Summary.
» Selectthe Edit link (Figure 3.4) next to the ACH Permission Summary.

KeyBank O
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Payments & Transfers -

support- £~ MyProfle  Sign Off
& | Manage Access X

Review permissions

User Controls Edit
Enable Notifications ON
Update Contant Information ON

Accounts that can be seen Egit
MONTE VISTA MOBILE HOME PARK ON

v 1 Accounts ted v

Accounts Requests Edit
MONTE VISTA MOBILE HOME PARK ON
v Accounts Selected v

Payments & Transfers Ealt

MONTE VISTA MOBILE HOME PARK FULL
ACCESS

v 1 Accounts Selected v
Bill Pay Edit
MONTE VISTA MOBILE HOME PARK ON
v 1 Accounts Selected .

Pay with ACH Eglt
TITLE NAME HERE ON
v 3 Accounts Selected v
User Credentials Edit

User ID

UserNameHere
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* Change the accountsettings forthe sub-user using the check boxes and toggles (Figure 3.5). You will only see
accounts thatare both added to your Pay with ACH service and that the sub-user has accessto view. The toggles will
selectorde-selectall accounts foracompany.

If you do not see accounts you wantthe sub-user to have
access to, try the following steps: Ensurethe sub-user has
& | Manage Access Y@l permissiontoviewthe account. Ensure the accountis
added to the Pay with ACH service.

Payments & Transfers - Tools Support - ‘@“ My Profile Sign Off

Select which accounts (sub- :
user name) can make ACH « Selectthe Confirm button once all changes are complete.

transactions from. You will return to the sub-user’'s permission summary.

Granting this permission enables the sub-
user to make payments using the Pay with

» SelectSubmit onthe permission summarypage to submit

ACH service. all permission changes.
S ik Y A confirmation message appears once the changes are
with ACH. .
submitted.

Each ACH transaction incurs a fee against
the account the transfer is made from

Pay with ACH permission for sub-users
may take up to 10 business days 10
process.

I can't find the account | want. &

A Company Tile -1 -~
FULL
ACCESS

Checking Accounts
Account Title - 0251

Account Title - 3487

Account Titls - 3483

Confirm

Figure 3.5: Sub-User ACH Permission Edit
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